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 Notices about this User's Manual
Carefully read this manual so that you can properly use this product.
T&D Corporation accepts no responsibility for any malfunction of and / or 
trouble with this product or with your computer that is caused by the improper 
handling of this product and will deem such trouble or malfunction as falling 
outside the conditions for free repair of the attached warranty.

- All rights of this user's manual belong to T&D Corporation. It is prohibited to 
use, duplicate and / or arrange a part or whole of this user's manual without 
the permission of T&D Corporation.

- Microsoft and Windows are registered trademarks of Microsoft Corporation 
in the United States and/or other countries. 

- Windows Vista is either a registered trademark or trademark of Microsoft 
Corporation in the United States and/or other countries. 

- Company names and product names are trademarks or registered 
trademarks of each company.

- Specifications, design and other contents are subject to change without notice.
- On screen messages in this manual may vary slightly from the actual 

messages.
- Please notify the shop where you purchased this product or T&D Corporation 

of any mistakes, errors or unclear explanations in this manual. T&D 
Corporation accepts no responsibility for any damage or loss of income 
caused by the use of our product.

- This product has been designed for private or industrial use only. It is not for 
use in situations where strict safety precautions are necessary such as in 
connection with medical equipment, whether directly or indirectly.

- We are not responsible for any malfunction or trouble caused by the use of 
our product or by any problem caused by the use of measurement results of 
our unit. Please be fully aware of this before using our product.

- Some of our products, which come under the category of strategic goods in 
foreign trade law, need the permission of the Japanese government to be 
exported outside of Japan.

- The Manual itself can be downloaded from our Web Site: 
 http://www.tandd.com.
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Software User Agreement 

 Disclaimers
- T&D Corporation does not guarantee the operation of "T&D Recorder for 

Windows TR-5,7xU".
- T&D Corporation shall not accept any responsibility for any damage, 

whether direct or indirect, that results from the usage of "T&D Recorder for 
Windows TR-5,7xU".

- Specifications of "T&D Recorder for Windows TR-5,7xU" may be subject to 
change and service may be terminated without advance notice to the user. 
In such a case, T&D Corporation shall not be responsible for any damages, 
whether direct or indirect, from the inability to use "T&D Recorder for 
Windows TR-5,7xU".

- T&D Corporation has no obligation to correct any defects found in "T&D 
Recorder for Windows TR-5,7xU".

 Copyright
- The Copyright for T&D Recorder for Windows, including the program and 

relevant documents, belongs solely to T&D Corporation.
- The reprinting or redistribution for commercial purposes whether in part or 

in whole, in magazines or as a part of any product is strictly forbidden 
without the expressed consent of T&D Corporation. Any inquires concerning 
commercial redistribution should be directed to the Sales Department of 
T&D Corporation.

- Please do not attempt to make any changes or modifications to "T&D 
Recorder for Windows TR-5,7xU".
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Using this software with Windows Vista / 7

 Notes about graph operation

Opening a Temp / Humidity Graph or other data file (.trx, etc...) by 
dropping it into the Graph window

If you wish to open a file by dropping it into a Graph, it will not appear if 
the Graph has been opened using [Run as Administrator]. Please open 
the Graph as a general User. In general, we suggest when using Vista / 
7 to only use [Run as Administrator] to open the Graphs the first time in 
order to link the type of data files (extension) to the Graph programs. 
After that please open as a general user and carry out the opening of 
data as usual.

 About the Saving Location for Data Files
The application automatically creates a new data file each time an Auto-
Download session occurs. Note that when using the Vista / 7 OS the 
[Virtual Store] function will redirect files from the default folder into which 
the program was installed to separate folders under [Program Files] for 
each user, as shown below: [C:\User\(AccountName)\AppData\Local\
VirtualStore\Program Files\(Application)].

EX:
If login was carried out using the account name [myname] and [T&D Recorder 
for Windows] is the application being run, the saving location will appear in the 
application window as: [C:\Program Files\(Application)] but due to the [Virtual 
Store] function the actual saving location will be [C:\User\myname\AppData\
Local\VirtualStore\Program Files\(Application)].
If the login was carried out from [Run as Administrator], the file will be saved 
to the folder as it appears in the application window.
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Before Using...

Important Notes about the Installation Procedure (for using this 
product with USB communication).
Thank you for choosing T&D Products. 

In order to use a USB connection to communicate between this product 
and a PC, it is necessary to install the application and the USB driver. 

Before connecting this product to a PC with a USB cable, it is 
necessary to first install the application and the USB driver.
If you use the USB cable to connect the product to a PC before 
installation, the USB driver may not properly install. 

If you have connected the product to a PC without first installing the 
driver, please make sure to press [Cancel] in the [Installation Wizard] 
window when it pops up the PC screen and then disconnect the USB 
cable from the product. 

For details about how to use, see [Basic Procedures] on P.6-8.
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What is "T&D Recorder for Windows TR-5,7xU"? 

 An Overview
"T&D Recorder for Windows TR-5,7xU" is a software program that 
enables you to easily make recording settings for our Data Loggers, 
download recorded data from the loggers, and then process that data 
into graphs, tables and /or save that data to files or print. Upon opening 
"T&D Recorder for Windows TR-5,7xU", a launcher program will appear 
with several icons l ined up. By cl icking on an icon, a sett ings/
communication display for the selected type of device or a graph display 
will appear.

In order to use the software, the following operational environment is 
necessary.

Compatible OS: Microsoft Windows 7  32/64bit English
Microsoft Windows Vista 32bit English
Microsoft Windows XP 32bit(SP2 or above) English

Disc Capacity: More than 50MB free space (More free space is necessary for 
data)

Operating Environment: A Stable Windows Operating Environment

* In order to install "T&D Recorder for Windows TR-5,7xU", it is necessary to have Administrator rights 

(Computer Administrator) for the computer in which you wish to install it.

 Basic Functions 

Recording Settings
Settings can be made for recording conditions such as channel name, 
recording interval, and recording mode. By making a recording start (date 
and time) setting in the main unit(s), the unit(s) will begin recording at that 
time on that date.

Graph Display / Printing
- Simultaneous Display of 8 Ch. of Data

It is possible to display up to 8 channels of downloaded data in 1 graph.
- Zoom-in on Data by Mouse

By simple mouse operations, you can easily zoom in and out on data as 
well as change the display.
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- View the High, Low, and Average Calculations for any Specified 
Period
Make settings to specify the calculation range you desire and view the 
high, low and average value for that range in each channel displayed in 
the graph.

Graph Printing
It is possible to print in full-color the graph as you see it on display.

Data List Display / Printing
You can view the data displayed in the graph window as a list and then 
choose to print.

View in Easy to Distinguish Colors
In the data list, the highest value will appear in red, the lowest in blue, 
and the average in pink.

Printing the Data List
It is possible to print the entire list as displayed or to select pages for 
printing.

Creating Text File
It is possible to convert the data for a specified range (time period) to 
common text file format (CSV type format), so that it can be exported to 
spreadsheet software such as Excel or Lotus.

Possible to use with a mixture of device types ( TR-5,TR-5i, TR-
5S, TR-7U,and TR-7Ui Series)
It is possible to process recorded data from a mixture of device types. 

This manual has been written using °C as the standard unit of temperature. 
User's in the United States and elsewhere who would like to change the unit 
to Fahrenheit, can easily do so by making changes in the "Shift Unit" under 
"Editing the Graph".
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Basic Procedures 

NOTE: 
- To make sure that the USB driver is properly installed, please follow the correct 

procedure as outlined here. 

 USB Communication for Windows Vista / 7
TR-71U/72U/73U/77Ui, TR-50U, TR-57U/57DCi

Installing the provided software  see P.10-12

Please follow the directions to install "T&D Recorder for Windows TR-5,7xU" .

Connecting the Data Logger/Data Collector 
or Communication Port to the Computer

For TR-50U, TR-57U, TR-57DCi: see P.18, 
For TR-71U, TR-72U, TR-73U, TR-77Ui: see P.20

Enable communication by connecting the Data Logger / Data Collector or 
Communication Port to the computer with a USB cable. 
Once the USB cable is connected, the USB driver will automatically be installed. 

Making Recording Start Settings
See [Basic Functions] for each type of device

NOTE: 

- Before making [Record Start] Settings make sure that your computer clock settings 
are correct. If your computer's clock is not correct, it will effect the date and time of 
the recording start.

Downloading Recorded Data
See [Basic Functions] for each type of device

Before downloading it is possible to make settings in the [Detailed Settings] to specify 
the what kind of processing should be done with the data after downloading, i.e. open a 
Graph or assign a file name and save. 

NOTE: 
- Before making Downloading Data make sure that your computer clock settings are 

correct. If your computer's clock is not correct, it will effect the date and time of the 
data being downloaded.
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 USB Communication for Windows XP 
TR-71U/72U/73U/77Ui, TR-50U, TR-57U/57DCi

Installing the provided software  see P.10-12

Please follow the directions to install "T&D Recorder for Windows TR-5,7xU" ..

Connecting the Data Logger/Data Collector 
or Communication Port to the Computer

For TR-50U, TR-57U, TR-57DCi: see P.18, 
For TR-71U, TR-72U, TR-73U, TR-77Ui: see P.20

Enable communication by connecting the Data Logger / Data Collector or 
Communication Port to the computer with a USB cable. 

Installing the USB Device Driver  see P.21-27

Please follow the directions to install the USB device driver after installing the USB device 
driver, your computer will be able to detect and recognize Data Logger / Data Collector or 
Communication Port that have been connected with a USB cable.

Making Recording Start Settings
See [Basic Functions] for each type of device

NOTE: 

- Before making [Record Start] Settings make sure that your computer clock settings 
are correct. If your computer's clock is not correct, it will effect the date and time of 
the recording start.

Downloading Recorded Data
See [Basic Functions] for each type of device

Before downloading it is possible to make settings in the [Detailed Settings] to specify 
the what kind of processing should be done with the data after downloading, i.e. open a 
Graph or assign a file name and save. 

NOTE: 
- Before making Downloading Data make sure that your computer clock settings are 

correct. If your computer's clock is not correct, it will effect the date and time of the 
data being downloaded.

Distributed by MicroDAQ.com, Ltd.                   www.MicroDAQ.com                   (603) 746-5524



8 Introduction

 Communicating via RS-232C
 TR-50C, TR-57U/57DCi

Installing the provided software  see P.10-12

Please follow the directions to install "T&D Recorder for Windows TR-5,7xU".

Connecting the Data Logger/Data Collector 
or Communication Port to the Computer

For TR-50U, TR-57U, TR-57DCi: see P.18, 
For TR-71U, TR-72U, TR-73U, TR-77Ui: see P.20

Enable communication by connecting the Data Logger / Data Collector or 
Communication Port to the computer with the provided or optional Serial 
Communication Cable.

Setting Up the Communication Port  see p.29- 

Please follow the directions to install "T&D Recorder for Windows TR-5,7xU" .

Making Recording Start Settings
see [Basic Functions] for each type of device

NOTE: 

- Before making [Record Start] Settings make sure that your computer clock settings 
are correct. If your computer's clock is not correct, it will effect the date and time of 
the recording start.

Downloading Recorded Data
See [Basic Functions] for each type of device

Before downloading it is possible to make settings in the [Detailed Settings] to specify 
the what kind of processing should be done with the data after downloading, i.e. open a 
Graph or assign a file name and save. 

NOTE: 
- Before making Downloading Data make sure that your computer clock settings are 

correct. If your computer's clock is not correct, it will effect the date and time of the 
data being downloaded.
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Installing the Software 

- Is Windows working properly?
If Windows is not activated properly, it may be impossible to install and run T&D 
Recorder for Windows.

- Quit all applications.
If you are running other applications, make sure to quit them before installation. If 
you have any permanently active software, such as a virus check or scan 
program in your computer, make sure to also quit it.

- In order to install Software, it is necessary to have Administrator 
rights (Computer Administrator) for the computer in which you wish 
to install it.

The layout of the installation window for "Windows 7" closely 
resembles that of "Windows Vista". When using "Windows 7" to 
install the Software and the USB Device Driver please refer to the 
installation instructions found under "Windows Vista" in the User's 
Manual provided with the product and follow on-screen messages 
as they appear. 

For information about operating the software, please carefully read 
the important notices and instructions found in the User's Manual. 

 For Windows XP
1. Start Windows.
2. Place the CD-ROM in the appropriate drive, and the [Install Program] 

window will automatically open.
* If the [Install Program] Window does not automatically open, please open it 

by double clicking on the CD-ROM icon in [My Computer]. 

Install T&D Recorder
 for Windows (TR-5,7xU)

[Execute]
Button
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3. Select [Install "T&D Recorder for Windows TR-5,7xU"] and by clicking 
on the [Execute] Button the installation will begin.

 Confirming the contents as you go, install the software according to the 
directions.

* Although warning messages may appear, there is no problem. Please move 
on to the next step. 

* After installation is completed, an icon for "T&D Recorder for WindowsTR-
5,7xU" will appear in the Start Menu.

 For Windows Vista / 7
1. Start Windows.
2. Place the CD-ROM in the appropriate drive.

*  If the window automatically appears, under [Install or run program], click on 
[Run start.exe]. 

Check

Distributed by MicroDAQ.com, Ltd.                   www.MicroDAQ.com                   (603) 746-5524



12 Getting Ready

3. The [Install Program] window will appear. 
* If the [Install Program] Window does not automatically open, please open it 

by double clicking on the CD-ROM icon in [Computer]. 

[Execute]
Button

Install T&D Recorder
 for Windows TR-5,7xU

4. Select [Install "T&D Recorder for Windows TR-5,7xU"], then click the 
[Execute] Button, the [User Account Controls] window should appear. 

5. Click [Next] to start the installation. Confirming the contents as you go, 
install the software according to the directions.

6. After the application has been installed, similar messages as follows 
will appear twice. Click the [Install] Button both times to complete the 
installation procedure. 

[Install]
Button

* After installation is completed, an icon for "T&D Recorder for Windows 
TR-5,7xU" will appear in the Start Menu.
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Operating the Software 

 Opening the Software
Open the software by clicking on "T&D Recorder for Windows TR-5,7xU" 
from the list of programs in the Start Menu.

 Main Window
Upon opening "T&D Recorder for Windows TR-5,7xU", a launcher 
window in which icons are displayed will appear. By clicking an icon, the 
graph, settings, and/or communication screen for that type of unit will be 
displayed.

Menu Bar

Icons

 [Menu Bar]
In the [Menu] Bar are Menus containing an array of commands. Click on the 
desired menu in the menu bar to set or display functions for each type of device.

 [Icons]
By clicking on an icon, the graph or communication display will appear for that 
type of unit. The graph and communication displays for each type of unit can also 
be viewed by clicking on that unit's type name in [Start] of the [Menu] Bar.
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 Help
- See the [Help] Menu of the software for more detailed information about 

how to use the software.
- To search for unclear words or terms, click the [Help] Menu that appears in 

the [Menu] Bar and then click on one of the tabs [Contents], [Index] or 
[Search].

[Contents]
Tab

[Index]
Tab

[Search]
Tab

[Contents] Tab
By clicking the mark of the classified topic, an explanation will be displayed.

[Index] Tab
Select a key word from the key word list and by clicking the [Display] Button, the 
explanation will be displayed.

[Search] Tab
Enter the key word you wish to search for and click the [Start Search] Button and 
the topic in which the key word is included will be displayed. Then select the topic 
and click the [Display] Button to have the explanation displayed.

- Click on the [Help] Button in any dialog box and explanations about the dialog box will be 
displayed.

- In the graph display window, after clicking on the [  ] in the toolbar, you can click on any 
Menu, any Icon, or any part of the Main window and an explanation will be displayed.
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 Date Display Format Settings: [Date Display] Menu
The date format chosen will be applicable for all sections of the software 
including graphs and setting displays. 

1. In the [Date Display] Menu, select [Format Settings] . 

2. Check either [Month/Date/Year] or [Date/Month/Year] .

[OK]
Button

3. By clicking the [OK] Button, the setting will be completed.
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Quick Start (TR-7U/TR-7Ui/TR-50U) 

When Windows is started, the [TR-71U/TR-72U/TR-73U/TR-77Ui/
TR-50U Quick Start Program] (from here [Quick Start] ) will be 
automatically started. When a TR-50U or TR-7U/TR-7Ui Series 
device is connected to your computer, the Quick Start will make a 
search and automatically open the application.

 Quitting Quick Start / How to Restart Again
Please see below for how to quit the Quick Start function and how to 
restart again.

[Quitting from the Taskbar]
1. Click the Quick Start icon in the Task tray to view the popup menu; in 

the popup menu click on [Quick Start Settings] . 

Click the Quick 
Start icon

2. Place a check next to [Do not use [TR-71U/TR-72U/TR-73U/TR-77Ui/
TR-50U Quick Start] ] and click the [OK] Button.

Check
here

[OK]
Button

[Re-start from the [Start Menu] ]
From the list of programs in the Window's [Start] Menu, click on [T&D 
Recorder for Windows (TR-5,7xU)] - [Quick Start] to restart the application. 
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[Quit / Start from each application]

1. Click on one of the icons (TR-71U/72U, TR-73U, TR-77Ui, 
TR-51A/52, TR-51i/52i or TR-51S/52S) in the Launcher Window. 

2. Click [Software Settings] in the [Settings] Menu.

[Settings] Menu

3. Remove the check mark from next to [Uppon Connecting a Thermo 
Recorder, open the software program.] and click the [OK] Button.

With no checkmark: Quick Start will be disabled 
With a checkmark: Quick Start will be enabled

[OK]
Button
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Connecting a Data Collector or  
Communication Port to the Computer

 For TR-50U, TR-57U, TR-57DCi
Connect the USB cable (US-15C) to your computer.

- Before using, it is necessary to have installed the USB device driver. (see P.21- ). 
- Make sure that the USB cable is inserted fully, so as not to cause an improper 

connection.

 For TR-50C, TR-57U, TR-57DCi
Connect the RS-232C (Serial) communication cable to your computer.

- Make sure to connect it to the correct place to ensure communication. 
- Make sure that the cable is inserted fully, so as not to cause an improper 

connection.
- Make all necessary Communication Port Settings in the Settings / Communication 

window for the Data Logger you are using. For details, see [Communication Port 
Settings] P.28-.
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Connecting the Data Logger to the Computer 

Connect the Data Logger to the computer using the appropriate 
method for that type of Data Logger. 

 For Data Logger with Optical Communication

- Compatible Loggers:TR-51A/52, TR-51i/52i, TR-51S/52S 

1. Connect the Communication Port to your computer using the provided 
communication cable.

Communication Cable

Data Collector or Communication Port

2. Place the Data Logger on top of the Communication Port device as 
shown in the figure, making sure that the optical communication spots 
are aligned properly.

 TR-57U, TR-57DCi (Data Collector)

 TR-50U, TR-50C (Communication Port)
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 For TR-71U/72U/73U/77Ui*1

Connect the TR-71U/72U/73U/77Ui unit to your computer with the USB 
Communication Cable (US-15C).

*1: If necessary, serial communication can be established by using our TR-73U/77Ui 
communication protocol (contact your local dealer) to write a software program. In this 
case, it will necessary to connect to your computer using our optional serial 
communication cable (TR-07C). Please contact your local provider for more details.

NOTE:

- To ensure proper communication, make sure that the USB cable connection is 
secure.

- This software is designed to operate TR-71U/72U/73U/77Ui units with USB 
connections and cannot operate the units via serial communication cables. If you 
wish to use serial cables to communicate with TR-71U/72U units, please install 
"Thermo Recorder for Windows (E) " from the CD-ROM menu and treat the units as 
TR-71S/72S units." Note that communication with TR-73U/77Ui via serial cable is 
not supported by the software.

- For more details about the use of "Thermo Recorder for Windows (E)" please refer 
to the PDF file contained in the CD-ROM. 

NOTE:

- To communicate with a TR-71U/72U unit via serial communication cable, please use 
our optional serial communication cable TR-07C. 

- If the place of connection is incorrect, communication will not occur. 
- To ensure proper communication, make sure that the communication cable 

connection is secure.
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Installing the USB Driver 

* In order to install "T&D Recorder for Windows", it is necessary to have 
Administrator rights (Computer Administrator) for the computer in 
which you wish to install it.

 For Windows Vista / 7

! For Windows Vista and 7, by installing "T&D Recorder for Windows 
TR-5,7xU" the USB device driver will also be automatically installed. 

1. Connect the Data Logger / Communication Port or Data Collector to 
the Computer.

- For details about connecting to the computer, see P.18-20.

2. In the [Control Panel] , click on [System Maintenance] and then click 
on [Device Manger] . 

* If you are using the [Classic] view, 
click the [Device Manager] icon. 

3. Check the icon displayed in the Device Manager Window. *1

*1:  Notation may differ slightly depending on 
the device being used. 

 For TR-71U/72U/73U/77Ui: USB Recorder1
 For TR-50U: USB Recorder3
 For TR-57U: USB Recorder2
 For TR-57DCi: TandD General UsbUart Port

NOTE:

- If the [Other devices] or [Unknown device] icon with an exclamation or a question 
mark appears in the Device Manager Window, see the "If USB Device Driver 
Installation Fails" (p.26). 
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 For Windows XP
*  After having installed "T&D Recorder for Windows TR-5,7xU" , 

please install the USB driver. 

1. Turn on your computer and open Windows.
2. Connect the Data Logger / Communication Port or Data Collector to 

the Computer.

- For details about connecting to the computer, see P.18-20.

3. By connecting a data logger to your computer, the [Welcome to the 
Found New Hardware Wizard] will automatically open.

- If it does not automatically open, please see the next page.

- If a window appears such as the one below, check [No, not this time] and 
then click the [Next] Button.

Check

[Next]
Button

4. By checking [Install the software automatically (Recommended)] and 
clicking [Next], the software will automatically be installed.

Check

[Next]
Button

5. After completing installation, click the [Finished] Button.
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If the driver is not automatically detected (Windows XP)
Follow the directions below to install.

1. Disconnect the USB cable from the Data Logger / Communication Port 
or Data Collector and then re-connect it. 

2. The [Add New Hardware Wizard] will automatically open.
- If a window appears such as the one below, check [No, not this time] and 

then click the [Next] Button.

Check

[Next]
Button

3. By checking [Install from a list or specific location (Advanced)] and 
clicking [Next], the installation process will begin.

Check

[Next]
Button
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4. Place a check next to [Include this location in the search: ], click the 
[Browse] Button and specify the location of the driver. 

Check

[Browse]
Button

[Next]
Button

- Select the driver for the device being used from the folder where "T&D 
Recorder for Windows TR-5,7xU" was installed. 
For TR-71U/72U/73U/77Ui: Driver TR-7xU 
For TR-50U: Driver TR-50U 
For TR-57U: Driver TR-57U 
For TR-57DCi: Driver TR-57DCi 
EX  C:\Program Files\T&D Recorder TR-5,7xU \Driver TR-57U 

5. After having selected the correct driver, click [Next] to start the 
installation. 

 After completing the installation, click the [Finished] Button. 

Confirming after Installation for Windows XP 
1. Connect the Data Logger / Communication Port or Data Collector to 

the Computer.

- For details about connecting to the computer, see P.18-20.

2. From the [Control Panel], click on [Performance and Maintenance] - 
[System]; the system properties will be displayed.

3. Click the [Hardware] Tab, and click the [Device Manager] Button in the 
Device Manager Area.
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[Device Manager]
Button

[Hardware] Tab

4. Check the icon displayed in the Device Manager Window. *1

 

 *1: Notation may differ slightly depending on the device being used. 
       For TR-71U/72U/73U/77Ui: [USB Recorder Com] - [USB Recorder1]
       For TR-50U: [USB Recorder2 Com] - [TR-50U]
       For TR-57U: [USB Recorder2 Com] - [USB Recorder2]
       For TR-57DCi: [Port (COM and LPT)] - [TandD General UsbUart Port]

NOTE:

- If under [USB Recorder Com] - [USB Recorder*] there appears a " ! " or a " ? ", or if 
in the Device Manager Window [? Other device?! USB Device] appears; that means 
the USB driver has not been installed properly. Please see [If USB Device Driver 
Installation Fails] (p.26- ) and re-install the driver as instructed. 
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If USB Device Driver Installation Fails 

If, during USB device driver installation, some trouble occurs that 
results in a failure to install properly, the following display will appear 
in the Device Manager.

EX: This mark means installation failure.

 For Windows Vista / 7
*  Even after having properly installed the provided software, there 

may be a few cases where USB communication cannot be carried 
out.

1. Right click on the icon for the "Unknown Device".

2. From the Menu, click on "Uninstall".

EX. Device Manager display for Vista

3. Then, reboot your computer. 

- It is NOT necessary to re-install the software. Connect the USB Cable and 
check communication.
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 How to Re-install for Windows XP
*  The images in the following explanation are taken from [Windows 

XP]. They may differ from the windows that appear when using 
other Operating Systems. 
1. In the [Control Panel], open [System].

2. In the System Properties Window, click the [Hardware] Tab, and then 
click the [Device Manager] Button in the [Device Manager] Area.

[Device Manager]
Button

[Hardware] Tab

3. In the Device Manager Window, right click on [USB Device] under [Other 
Devices] and then click on [Properties] to display the [USB Device 
Properties] Window.

4. In the USB Device Properties Window, click on the [Re-install Driver] 
Button to display the Hardware Detection Wizard. Follow the directions 
to install.

[Re-install Driver]
Button
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Setting Up the Communication Port

Settings for both USB and RS-232C communication can be made 
from the same window. It is also possible to confirm current 
communication settings. 

NOTE:

- When using TR-7U/7Ui Series units, it is not necessary to make COM Port Settings. 
- When using USB, the USB driver must be properly installed for USB communication 

to properly work. 

 For using USB
1. Place the Data Logger face down on top of the Data Collector or 

Communication Port to enable optical communication.

2. Connect the USB cable to your computer.

3. Open the appropriate application for the type of device being used.

Make settings with TR-5 Series, TR-5i Series, TR-5S Series, TR-57U 
or TR-57DCi units. By making settings for one unit the same COM 
Port settings will be made for all device types. 

4. In the [Communication] Menu open [Communication Port Settings]. 

[Communication] Menu
Communication Port Settings
Window

5. Check [USB].

6. Click the [Set] button to finish settings. 

[Set] ButtonCheck
[USB]
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 For using RS-232C
Make necessary Serial Port Settings to enable communication via RS-
232C serial communication cable.

1. Place the Data Logger face down on top of the Data Collector or 
Communication Port to enable optical communication.

2. Connect the RS-232C serial communication cable to your computer.

3. Open the appropriate application for the type of device being used.

Make settings with TR-5 Series, TR-5i Series, TR-5S Series, TR-57U 
or TR-57DCi units. By making settings for one unit the same COM 
Port settings will be made for all device types. 

4. In the [Communication] Menu open [Communication Port Settings]. 

[Communication] Menu Communication Port Settings
Window

5. Check [Communicate via RS-232C].

6. Make settings for "Possible COM Ports".

Check here, when using Communication Port above COM9

[Set] Button
Check
[Communicate 
via RS232C]

Setting
[Possible COM Ports]

7. Click the [Set] button to finish settings. 
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 For an Automatic Search: [Auto-Detect] button

1. Place the Data Logger face down on top of the Data Collector or 
Communication Port to enable optical communication.

2. Connect the communication cable (USB or RS-232C) to your 
computer.

3. In the [Communication Port Settings] Window, check [USB] or 
[Communicate via RS-232C] and click on the [Auto-Detect] button.

  

[Auto Detect] 
Button

4. After the search has been completed, a message will appear.

5. If the unit has properly been detected click the [Yes] button.

  

NOTE:

- If no unit was detected, see "Troubleshooting" on page 108. 
- If the port number being used is COM9 or above the unit can not be automatically 

detected.
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Basic Function
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TR-71U/72U/73U/77Ui: Basic Functions 

 Display Names and Functions

Toolbar

Device List

Device Properties

Menu Bar

Settings
Area

[Menu Bar]
The menus along the bar contain various helpful commands. From each menu, 
you can select commands to view or make settings for each of the device types.

[Toolbar]
The commands that are used most frequently have been arranged as buttons.

[Device List]
TR-71U/72U/73U/77Ui units connected to the computer by USB cable will be 
displayed as icons here. In order to make recording settings or download 
recorded data, it is necessary to first select a device from the device list. The type 
of icon used in the display can be changed in the [View] Menu.

[Device Properties]
Information about the device selected in the device list will be displayed here. If 
more than one data logger has been selected no information will be displayed.

[Settings Area]
By clicking on the [Download Recorded Data] Tab or the [Start Recording] Tab, 
you can open the settings display for that function.

Distributed by MicroDAQ.com, Ltd.                   www.MicroDAQ.com                   (603) 746-5524



Basic Function 33 

TR-71U/72U/73U/77Ui: Starting Recording

Connect a TR-71U/72U/73U/77Ui unit to your computer so that 
communication can occur. Please make sure that your computer 
clock settings are correct.

- Please see P.20 for more information about how to connect.
-  The first time you connect it is necessary to install the USB device 
driver. For information about how to install the device driver 
please see the TR-71U/72U/73U/77Ui User's Manual.
1. In the Main Window, click on the [TR-71U/72U], [TR-73U],or [TR-77Ui] 

icon. 

2. Click on the icon of the Data Logger you wish to make settings for.

3. Click the [Start Recording] Tab, and make the necessary settings.

Click on
 the icon

[Stop Recording]
 Button

[Receive Settings]
 Button

[Start Recording] Tab

[Start Recording]
 Button

Recording Start Date/Time 
(Selections from: Programmed Start / Immediate Start)
Programmed Start: recording will start on the specified date and time. 
Immediate Start: recording will start immediately upon completion of settings. 

Recording interval 
(Select from:1, 2, 5, 10, 15, 20, 30 seconds1, 2, 5, 10, 15, 20, 30, 60 minutes)
Click on [ ] and select the desired recording interval from the drop-downlist.
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Recording Mode 
(Selections from: One-time/Endless)
One-time:  When the possible number of recorded data readings(8,000 readings 

per channel) is reached, recording stops.
Endless:  When the possible number of recorded data readings is reached, the 

oldest data is overwritten and recording continues.

Infrared Comm. (TR-77Ui)
Forbid: Infrared communication function cannot be used. 
Permit: Infrared communication function can be used. 

- The default setting is "Forbid". Battery life will be shortened by carrying out 
infrared communication; we recommend setting to "Forbid" infrared 
communication when you do not wish to use it.

- It is also possible to switch between forbidding and permitting infrared 
communication from the [Infrared Communication Settings] window in the 
[Settings] Menu.

- If you set to "Permit" infrared communication, it will not be possible to 
communicate via serial communication.

- In order to carry out infrared communication, it is necessary to have T&D’s 
Data Collector TR-57DCi.

Device Name/Channel Name
Make settings for each data logger concerning the device names and channel 
names.
Device Name: Up to 32 characters 
Channel Name: Up to 16 characters 

4. After having completed the recording conditions settings, transmit the 
settings to the data logger by clicking the [Start Recording] Button. 

5. After the transmission has been completed, a message will appear; 
click the [OK] Button to activate the settings.

[Stop Recording] Button
Clicking this Button will stop a recording session already in progress.

[Receive Settings] Button 
Clicking this will allow you to view recording condition settings and recording 
status information from the data logger.
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TR-71U/72U/73U/77Ui: Downloading Recorded Data

Connect a TR-71U/72U/73U/77Ui unit to your computer so that 
communication can occur.
* Please see P.20 for more information about how to connect. 
*  The first time you connect it is necessary to install the USB device 

driver. For information about how to install the device driver 
please see the TR-71U/72U/73U/77Ui User's Manual.
1. In the Main Window, click on the [TR-71U/72U], [TR-73U],or [TR-77Ui] 

icon.

2. Click on the icon of the Data Logger you wish to download data from.

3. Click the [Download Recorded Data] Tab.

Select a data 
logger

[Detailed Settings]
Button

[Download Recorded Data] Tab

[Download]
Button

4. If you wish to automatically display the graph upon the completion of 
downloading, click the [Detailed Settings] Button to make such a 
setting.

- For more information about [Detailed Settings] see next page.

5. Click the [Download] Button to begin downloading data.

6. After downloading has been completed a graph will be displayed.

Distributed by MicroDAQ.com, Ltd.                   www.MicroDAQ.com                   (603) 746-5524



36 Basic Function

 Detailed Settings
Make settings about how to process downloaded recorded data.

[File Name Settings]

[Graph Display Settings]
[OK]
Button

[Graph Display Settings]
By checking here, the graph for the downloaded data will automatically appear 
after downloading is completed. 
Up to 8 channels of data can be simultaneously displayed. 

NOTE: 

- If there are more than 8 channels of data, that data cannot be displayed 
automatically and must be opened from the data file. 

[File Name Settings]
You can choose to save downloaded data using a default file name or by 
assigning a name each time. 

1. Choose the type of processing you desire.

2. By clicking the [OK] Button the setting will be completed.

- You can specify the type of default file name under [File]– [File Names and 
Folders].
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TR-71U/72U/73U/77Ui: Other Functions 

 Open Temp/Humidity Graph: [File] Menu
Opens the Temperature / Humidity Graph.

 File Names and Folders: [File] Menu
Specify how you wish the files to be named upon downloading recorded 
data. Also you can select in which folder to use to save data for each 
device.

[Default File Name Settings]

Check one from the 
[Default File Name 
Settings]

[OK]
Button

1. Check which type of file name you wish to use to save data.

Example:
Device Name: Refrigerator/Serial No.: 00001234/Date and Time:  
2003/05/12(yyyy,mm,dd)at 14:30: 15/with Data Format Extension: TRX

- Device Name+Date/Time: Refrigerator_20030512_143015.trx 
- Internal ID +Date/Time: 00001234_20030512_143015.trx
- Device Name+ Internal ID +Date/Time: Refrigerator_00001234_20030 512_143015.trx
- Date/Time+Device Name: 20030512_143015_Refrigerator. trx
- Date/Time+Internal ID: 20030512_143015_00001234.trx
- Date/Time+Device Name + Internal ID: 20030512_143015_Refrigerator_00001234.trx

2. By clicking the [OK] Button, the settings will be completed.
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[Saved Folder Settings]
Assign a saving location for the data file.

Saving Location

Click here

[Select Folder]
Button

[OK]
Button

1. The TR-71U/TR-72U/TR-73U/TR-77Ui unit(s) connected by USB cable 
to your computer will appear in the list.

2. Click the name of the device and then click the [Select Folder] Button.

3. The [Browse Folders] dialog box will appear where in you can select the 
folder into which you wish to save the data, then click [OK].

4. A [Data Folder] will then appear under Device Properties in the Main 
Window.

- The default setting will create and save data to a folder with the device's 
serial number in the same folder where T&D Recorder for Windows was 
installed. 

 Large Icon/Small Icon: [View] Menu
Changes the icon size in the Device List between large and small.

Small IconLarge Icon
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 Monitor Current Readings: [Communication] Menu
You can monitor at set intervals the current readings of Data Logger or 
loggers selected from the device list and have those readings displayed.

Settings Display

[Clear]
Button

[Settings] Button: 
This opens a window where settings can be made for the display colors and 
the monitoring interval for current readings.

[Close] Button:
Quit the Monitoring of Current Readings.

[Reset] Button:
Click to reset the display for highest and lowest measurements; the new 
display will show highest and lowest measurements from the time of resetting.

[Graph] Button:
Click this to hide or view the graph.

[Clear] Button:
Clicking this will clear the graph and a new graph will be drawn from that 
point.
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 Search for TR-71U/TR-72U/TR-73U/TR-77Ui: 
[Communication] Menu

If a TR-71U, TR-72U, TR-73U,or TR-77Ui is connected, but does not 
show up in the Device List, click this to search for Thermo Recorders by 
scanning the USB ports.

 Device Name Settings: [Settings] Menu
Settings can be made for Device Names and Channel Names.

For TR-71U/72U/77Ui

Enter a name 
[Send Settings] 
Button

For TR-73U

Enter a name 
[Send Settings] 
Button

1. Enter a name.
- Device Name: up to 32 characters
- Channel Name: up to 16 characters.

2. By clicking the [Send Settings] Button, the changes will be completed.
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 LCD Display Settings: [Settings] Menu
Settings can be made for the Thermo Recorder's LCD display, such as, 
changing the temperature unit and turning the display on or off.

[Temp. Unit in Display]

For TR-71U/72U/77Ui

Check one of these
[Send Settings] 
Button

For TR-73U

Check one of these [Send Settings] 
Button

1. Check either Celsius or Fahrenheit.
2. By clicking the [Send Settings] Button, the changes will be completed.
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[LCD Display Pattern] 

For TR-71U/72U/77Ui

Check one of these

[Send Settings] 
Button

- You can select the LCD display from 3 patterns: Alternate display between 
Ch.1 and Ch.2, Display Ch. 1 only, or Display Ch. 2 only.

For TR-73U

Check one of these

[Send Settings] 
Button

-  You can select the LCD display from 4 patterns: Alternate display among 
Ch.1, Ch.2 and Ch.3, Display Ch.1 only, Display Ch.2 only or Display Ch.3 
only.

1. Check one of the patterns. 
2. By clicking the [Send Settings] Button, the changes will be completed.
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 Adjustment Settings: [Settings] Menu
By setting adjustment values beforehand, you can record and display the 
post- adjusted measurement values. You can choose from two 
adjustment methods: 1-point and 2-point. Adjustment will be carried out 
using an adjustment equation of Y= aX + b; where X is the pre-adjusted 
measurement value and Y is the post-adjusted value.

Rough Guidelines for Adjustment
1 point Adjustment: Use when measuring in a range of 20 .
2 point Adjustment: Use when measuring in a wide range.

NOTE:

- When adjusting at 2 points, make sure the difference in points is at least 10 .
- When measuring in a wide range and adjusting at 2 points, make sure that the 

adjustment values reflect the range you are measuring.
- We cannot guarantee that after carrying out adjustment the measuring accuracy will 

improve for all measuring ranges.

1. Check the channel you wish to adjust.
Check here

[Save File] Button

Check one, and enter
the value

[Read File] Button

[History] Column 

[Send Settings] 
Button

[Initialize] Button

2. Place a checkmark next to either [1 Point Adjustment] or [2 Point 
Adjustment] and enter the [Before] and [After] values. 

3. By clicking the [Send Settings] Button, the adjustment settings will be 
completed.

- The Data Logger can store up to 4 adjustment values, the adjustment history 
will display up to 4 channels at one time.
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[1 Point Adjustment]
This adjustment method changes only the offset (b) where the slope (a) is 
considered 1. 
For example, TR-71U is measuring 10°C, but the standard says the actual 
measurement should be 10.2°C. Enter 10 in the Before Adjustment box and 
10.2 in the After Adjustment box. The conversion equation will be Y=X + 0.2 
and for all measurements an adjustment to the offset of +0.2 will be made. 

[2 Point Adjustment]
The adjustment equation will be calculated from two points: the slope (a) and 
the offset(b).
For example, the TR-71U reads 0°C when the standard thermometer reads 0.4
°C, and TR-71U reads 10°C when the standard says the true measurement is 
10.2°C. In this case the slope(a)is 10.2 - 0.4/10-0 = 0.98. The offset is 0.4, so 
the conversion equation becomes Y = 0.98X + 0.4. The range of the slope is 0 
< a < = 2. Entries are valid to one decimal point, but after calculation up to 
four digits are valid for the slope and offset.

[Initialize] Button
This returns the control settings back to their original factory default settings.

[Save File] Button
Assign a name to the adjustment setting values and save them to a file.

[Read File] Button
Read adjustment setting values from a saved file.
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 Software Settings: [Settings] Menu
General software settings for TR-71U/TR-72U/TR-73U/TR-77Ui can be 
made here.

[Upon connecting a Thermo Recorder, open the Software Program]
This setting opens the software program upon the connection of a TR-71U/
TR-72U/TR-73U/TR-77Ui unit via USB cable. If the setting is ON, the Quick 
Start Program will periodically communicate with the device driver and upon 
the detection of a USB connection will open the main software program.

- For more details about [Quick Start] and how to quit it, see P.16-.

1. Place a check next to [Upon connecting a Thermo Recorder, open the 
Software Program].

With no checkmark: Quick Start will be disabled 
With a checkmark: Quick Start will be enabled

[OK]
Button

2. Click [OK] to complete the setting.

[Temp. Unit to be displayed in Software Program]
Select whether to use Celsius or Fahrenheit as the displayed unit of 
temperature when monitoring current readings and using the adjustment 
function.

1. Check either unit of temperature (Celsius or Fahrenheit).

Check here

[OK]
Button

2. Click [OK] to complete the setting.
3. After completing settings, please close the TR-71U/72U/TR-73U or 

TR-77Ui program and reopen it to make settings effective.
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TR-51A/52: Basic Functions

Connect the TR-51A/52 to your computer to enable communication. 
Please make sure that your computer clock settings are correct.

- See P.19 for details about how to connect. 

 Set the Recording Conditions
1. In the Main Window, click the [TR-51A/52] icon.
2. Click the [Start Recording] Tab and make any necessary settings.

[Start Recording]
Button

[Start Recording] Tab

Recording Start Method
(Selections from: Programmed Start / Immediate Start)

- Programmed Start: Recording will begin on the day and time entered.
- Immediate Start: Recording will begin as soon as settings are 

completed. 

Recording Interval 
(Select from: 1, 2, 5, 10, 15, 20, 30 seconds* / 1, 2, 5, 10, 15, 20, 30, 60 
minutes)
By clicking [ ] you can select from the recording interval list. 

* TR-51A cannot be set using seconds.
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Unit Name 
(Selections from: TR-51A/TR-52)
By clicking [ ] you can select depending on the device you wish to make 
settings for.

Recording Mode
(Selections from: One-time / Endless)

- One-time: When the number of readings has reached 16,000, the unit 
display will read FULL and recording will automatically stop. 

- Endless: When the number of readings reaches 16,000, the next one 
will overwrite the oldest or first reading.

Channel Name
Channel names can be entered with up to 8 letters.

Unit of Temperature 
(Selections from: Celsius [°C ] or Fahrenheit [°F ] )
Change the display of temperature on the data logger between [°C ] and [°F ] 
.

3. After making all the desired settings, click the [Start Recording] Button 
to transmit them.

4. After transmission has been completed the communication result will 
appear. By clicking [OK], the set-up process will be finished. By clicking 
[OK], you can close the window.
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TR-51A/52: Downloading Recorded Data

Connect the TR-51A/52 to your computer to enable communication.
- See P.19 for details about how to connect. 

1. In the main window, click the [TR-51A/52] icon.

2. Click on the [Download Recorded Data] Tab.

[Download Recorded Data] Tab

[Download] 
Button

[Detailed Settings]
Button

3. If you wish to automatically view the graph after downloading, click the 
[Detailed Settings] Button and make the appropriate detailed settings.

- See next page for more info about [Detailed Settings].

4. Click the [Download] Button to start downloading.

5. After downloading has been completed, the graph will be displayed. 
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[Detailed Settings] Button
This opens the window in which settings for the processing of data after it has 
been downloaded can be made Select from the four processing methods.

[OK]
 Button

[Browse for Folder] 
Button

Selecting the Data Processing Method
[After downloading, automatically show graph]
[After downloading, specify file in which to save data]
[After downloading, specify file name and automatically show graph] 
[Automatically save file]*

*  Click the [Browse for Folder] Button to specify the file saving 
location. A file with the name [download date and time_channel 
name.trx] will be saved in the specified folder.
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TR-51A/52: Other Functions

 Software Settings: [Settings] Menu

[Upon Connecting a Thermo Recorder, open the Software 
Program]
This setting opens the software program upon the connection of a TR-51A/52 
unit via USB cable. If the setting is ON, the Quick Star t Program will 
periodically communicate with the device driver and upon the detection of a 
USB connection will open the main software program.

- For more details about [Quick Start] and how to quit it, see P.16.

1. Place a check next to [Upon Connecting a Thermo Recorder, open the 
Software Program].

With no checkmark: Quick Start will be disabled 
With a checkmark: Quick Start will be enabled

[Settings] Menu

[OK]
 Button

2. Click [OK] to complete the setting.

[Temp. Unit to be displayed in Software Program]
Select whether to use Celsius or Fahrenheit as the displayed unit of 
temperature when monitoring current readings and using the adjustment 
function.

1. Check either unit of temperature (Celsius or Fahrenheit).

[OK]
 Button

Selection

2. Click [OK] to complete the setting.

3. After completing settings, please close the TR-51A/52 program and 
reopen it to make settings effective.
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 Communication Port Settings: [Communication] Menu
Make settings for USB and/or RS-232C communicationIn the TR-51A/52 
[Communication] Menu open [Communication Port Settings]. 

Communication Port Settings
Window

- For details about Communication Port Setting Procedures see p.28-30. 
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TR-51i/52i and TR-51S/52S: Starting Recording

NOTE:

- If the computer system clock is incorrect, a programmed recording start may not 
start properly. Please make sure that your computer clock settings are correct.

1. Connect the Data Logger you wish to make settings for to your 
computer. 

- For details about connecting to your computer, see page 19.

2. In the Launcher Window, click on one of the icons [TR-51i/52i] or 
[TR-51S/52S], and the settings window will appear. 

[Receive Settings] 
Button
[Stop Recording] 
Button

[Warning Report 
Settings] Button

[Start Recording] 
Button

[Start Recording] Tab

Recording Start Method

- Programmed Start: Recording starts on the set date and time. 
- Immediate Start: Recording starts immediately upon completion of the 

settings. 

Recording Interval 
Select from 15 choices: 1, 2, 5, 10, 15, 20 and 30 (seconds) / 1, 2, 5, 10, 15, 
20, 30 and 60 (minutes)
Select the desired interval from the list in the Recording Interval Box. (Default 
setting is 10 min.) 
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Recording Mode

One-time: Upon reaching the storage capacity of 16,000 readings, the word 
[FULL] wi l l appear on the LCD display and recording wi l l 
automatically stop. 

Endless: Upon reaching the storage capacity of 16,000 readings, the oldest 
data is overwritten and recording continues. 

-  The estimated finish date and time of recording in One-time mode will be 
automatically calculated from the set recording interval and starting time. 

Channel Name
By placing a check in the [Set] box, you can enter a channel name with up to 
8 characters. 

Unit of Temperature 
(Selections from : Celsius [°C] or Fahrenheit [°F] )
Change the display of temperature on the data logger between [°C] and [°F].

[Infrared Communication] (TR-51i / 52i only) 

Forbid: Infrared Communication will not be possible. 
Permit: Infrared Communication will be possible. 

* If you are using TR-57DCi and do not wish to use infrared communication, we suggest 
selecting “Forbid”. (Battery life will be longer.) 

* Forbid / Permit settings for infrared communication can also be made from [Infrared 
Communication Settings] in the [Communication] menu.

3.  After making the necessary recording condition settings, click the [Start 
Recording] button and the settings will be transmitted to the Data 
Logger. 

4.  When a transmission result message appears, click the [OK] button 
to complete the setting procedure. 

[Receive Settings] Button 
Use this button to read the settings from the connected Logger. 

[Stop Recording] Button 
Use this button to stop recording. 

[Warning Report Settings] Button 
See the next page. 
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[Warning Report Settings] Button: Warning Monitoring Function

Starting the Warning Monitoring Function
If these settings are made in an environment where one of the limits is being 
exceeded and recording is started, the monitoring function will enter “wait” mode. 
Once a measurement returns to within the set limits, the monitoring function will 
begin to operate. 

1. By clicking the [Warning Report Settings] button in the [Start 
Recording] tab, the settings window will appear. 

2. Place a check in the [Set Limits] box after entering the Upper and 
Lower Limits and the Judgment Time. 

[OK]
Button

By placing a checkmark here the 
settings will become active.

[Upper Limit / Lower Limit]
The Upper / Lower Limits can be set in a range from -60°C to 155°C. 
When you wish to change the unit of temperature, go to the [Settings] Menu, 
open the [Software Settings], and edit temp. unit. 

[Judgment Time]
A warning occurs when a measurement exceeds one of the set Upper / Lower 
Limits for longer than the time set as the Judgment Time. The warning LED will 
flash and a warning message will appear on the LCD screen. 

- The judgment time can be set from the following selections: 10, 15, 20, 30 
seconds or 1, 2, 5, 10, 15, 20, 30, 60 minutes.

3. By clicking the [OK] button, a confirmation message will appear.

4. By clicking the [OK] button again, you will be returned to the [Start 
Recording] Tab Window and the settings will be completed.
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TR-51i/52i and TR-51S/52S:   
Downloading Recorded Data

NOTE:

- If the Data Collector clock is incorrect, the date and time for wireless recording start 
and the downloading of data may be incorrect. Please make sure that the Data 
Collector clock is correct. 

1. Connect the Data Logger you wish to make settings for to your 
computer. 

- For details about connecting to your computer, see page 19.

2. By clicking on one of the icons [TR-51i/52i] or [TR-51S/52S] in the 
Launcher, the settings window will appear. 

3. Click the [Download Recorded Data] Tab to make settings for the 
download conditions. 

Place a check here 
to specify data by 
time.

[Download Recorded Data] Tab

[Download]
Button

[Detailed Settings]
Button

[Detailed Settings] Button:   
Making Settings for Processing after Downloading 
Settings can be made for the data processing method after downloading. 

[OK]
 Button

[Browse for Folder]
 Button
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[After downloading, automatically show graph.]
Downloaded data will be automatically saved into a file, and the graph will appear.

- File names cannot be specified.

[After downloading, specify file in which to save data.]
The [Save File] dialog box will appear after downloading, where you can assign a 
name to the file to be saved.

- Graph will not be displayed.

[After downloading, specify file name and automatically show graph.]
Downloaded data will be saved into a specified fi le, which can then be 
automatically viewed in graph form. 

[Automatically save file.]
Downloaded data will be automatically saved into a specified folder.Click the 
[Saved Folder Settings] button to select the folder you wish to save the data into.

- If the folder has not been specified, the file will automatically be stored to the 
same folder into which the application was installed.

4. Click the [Download] button to start downloading. 
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TR-51i/52i and TR-51S/52S: Other Functions

 Checking for Warning Occurrences: [Warning Times] Button
NOTE: 

- When using Communication Port TR-50C, this function cannot be used. 
- Even if more than one warning occurred, only the first one will be shown in the most 

recent list.

1. Connect the Data Logger to your computer to carry out communication. 
(See page 19.) 

2. In the [Download Recorded Data] Tab Window, click the [Warning 
Times] Button. 

[Download Recorded Data] Tab

[Warning Times] 
Button

3. By clicking the [Receive Most Recent Time] Button, it is possible to 
check warning times in the [Warning Occurrence Times] Column. 

[Warning Occurrence Time] Column

[Receive most recent time] 
Button
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 Removing a Warning Mark from the Data Logger Display 
A warning LED can be removed from the Data Logger display by one of 
the following three methods: 

[Clear Occurrence Times from Main Unit] Button 
Connect the Data Logger to your computer, and click the [Clear Occurrence 
Times from Main Unit] button in the [Warning Time] display to complete the 
removal. 

[Clear Occurrence Times 
from Main Unit]
Button

- This will have no effect on the already recorded data; measurement and 
recording will continue without interruption.

- Confirm that in the Warning Occurrence Time Column, [None] appears.

[Download Data]
Once data downloading has been successfully completed, the warning mark 
will disappear. 

[Re-start a Recording Session]
The mark will disappear whenever a new recording session is started. 
(Recorded data will be erased.)
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 Software Settings: [Settings] Menu

[Upon Connecting a Thermo Recorder, open the Software 
Program]
This setting opens the software program upon the connection of a TR-51i/52i 
or TR-51S/52S unit via USB cable. If the setting is ON, the Quick Start 
Program will periodically communicate with the device driver and upon the 
detection of a USB connection will open the main software program.

- For more details about [Quick Start] and how to quit it, see P.16.

1. Place a check next to [Upon Connecting a Thermo Recorder, open the 
Software Program].

With no checkmark: Quick Start will be disabled 
With a checkmark: Quick Start will be enabled[Settings] Menu

[OK]
 Button

2. Click [OK] to complete the setting.

[Temp. Unit to be displayed in Software Program]
Select whether to use Celsius or Fahrenheit as the displayed unit of 
temperature when monitoring current readings and using the adjustment 
function.

1. Check either unit of temperature (Celsius or Fahrenheit).

[OK]
 Button

Selection

2. Click [OK] to complete the setting.

3. After completing settings, please close the TR-51i/52i or TR-51S/52S 
program and reopen it to make settings effective.
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 Adjustment Settings: [Communication] Menu
Adjustment is a function used to make adjustments to Remote Unit 
measurements. By making adjustments to measurements, the adjusted 
measurements will be displayed and recorded. 

NOTE:

- We cannot guarantee that after carrying out adjustment the measurement, accuracy 
will improve for all measuring ranges. 

- If you remove a sensor that was connected when adjustment was carried out and 
then connect a different sensor, make sure to make new adjustment settings to 
reflect the actual situation. 

- If new adjustment settings are made on already adjusted values, the probability of 
measurement errors will increase. Make sure to click the [Initialize] button before 
making any new adjustment settings on already adjusted values. 

- When you are carrying out adjustments and formulating equations, please take care 
with the settings and take personal responsibility for the process. 

1. Connect the Data Logger to your computer. (See page 19.) 

2. In the [Communication] Menu, click [Adjustment Settings] to open the 
settings window. 

Select the adjustment method 
and enter the values.[Communication] Menu

[Initialize]
Button

[Send Settings] 
Button

[History] Column
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3. Check the Method of Adjustment: [1 Point Adjustment] or [2 Point 
Adjustment]. 

- 1 Point Adjustment: Use when measuring in a range of 20°C.
- 2 Point Adjustment: Use when measuring in a wide range.

4. Enter the actual measurement before adjustment in the [Before] box 
and the desired measurement after adjustment in the [After] box. 

- For "Rough Guidelines for Adjustment", see the next page.

5. By clicking the [Send Settings] button, a confirmation message will 
appear. Then click the [OK] button to transmit the adjustment settings. 

[Initialize] Button
Clears any previous adjustment equation(s) and initializes the device. 

[History] Column 
The latest 4 adjustment history records will be displayed. The records show 
the date and time that adjustment settings were made, the adjustment 
point(s), and the values for “Before” and “After” adjustment. 

 Communication Port Settings: [Communication] Menu
Make settings for USB and/or RS-232C communicationIn the TR-51i/52i 
or TR-51S/52S [Communication] Menu open [Communication Port 
Settings]. 

Communication Port Settings
Window

- For details about Communication Port Setting Procedures see p.28-30. 
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TR-57U/57DCi: Setting the Clock

NOTE: 

- If the Data Collector clock is incorrect, the date and time for wireless recording start 
and the downloading of data may be incorrect. Please make sure that the Data 
Collector clock is correct. 

1. Connect the Data Collector to the Computer. 
- For details about connecting to your computer, see pages 18-19.

2. By clicking the icon for the “Data Collector” being used in the Launcher, 
the settings window will appear. 

3. Click the [Set Clock] tab, and make the necessary clock settings. 

 TR-57U: Settings Window  TR-57DCi: Settings Window

[Set Clock] Button
[Set Clock] Tab [Set Clock] Tab

[Set Clock] Button

  Set the specified clock settings. 
  If checked:
  The date / time entered will be set as the date / time in the Data Collector. 
  If not checked:
   The current date / time of your computer will be set as the date / time in the Data 

Collector.

4. After entering the settings, click the [Set Clock] button to have the 
settings sent to the Data Collector. When the confirmation message 
appears, click the [OK] button to complete the setting procedure. 
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TR-57U/57DCi: Downloading Recorded Data

Here it is possible to download the collected data from the Data 
Collector to your computer. 

NOTE: 

- If the computer system clock is incorrect, the date and time of the downloaded data 
may be incorrect. Please make sure that the computer system clock is correct. 

- If you are unsure of what version you have, please check the version information in 
the Data Collector’s [Help] menu. 

- Please note when using TR-57U to collect data from TR-71U/72U (Remote Units), 
the "Unit Type" in the recorded data list will be shown as "TR-71S/72S". The data 
collected from TR-77Ui will be shown as "TR-77Ui". When using TR-57DCi (Data 
Collector) to collect data from TR-73U and TR-74Ui (Remote Units), the "Unit Type" 
in the recorded data list will be shown as "TR-73U"/"TR-74Ui". TR-57DCi is the only 
compatible Data Collector for TR-73U/74Ui. 

- Also when using TR-57DCi to collect data from TR-72U/72S will be shown as 
TR-72x.

 Gathering Data Collector Info
1. Connect the Data Collector to your computer. 

- For details about connecting to your computer, see pages 18. 

2. By clicking the icon for the "Data Collector" being used in the Launcher, 
the settings window will appear. 

3. Click the [Download Recorded Data] tab, and then click the [Collect 
Data Info] button to start the gathering of info. 

[Download Recorded Data] Tab

[Collect Data Info]
Button

Data Collector 
Contents List

[Quit Collecting
 Data Info] Button
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NOTE:

- The chart in the previous page is an example of the settings window for TR-57U. 
The settings window for TR-57DCi does not have an [Upper and Lower Limit 
Settings] Tab.

- By using TR-57DCi, it is also possible to collect data from TR-73U/TR-74Ui

4. When communication has been completed, the data info will appear in 
the "Data Collector Contents" List.

No. Indicates the data number (1 to 250) assigned in the order of 
collection. By clicking the [No.] title area you can change the 
order between ascending and descending. 

Unit Type TR-51S, etc... indicates the type of unit, such as TR-51S.

ch.1 (Group) Name Shows the Channel 1 Name. 

ch.2 (Remote) Name Shows the Channel 2 Name. 

Recording Start Date/
Time

Displays the recording start date and time for the data 
gathered by the Data Collector. 

Data Collection Date/
Time

Displays the date and time the data was downloaded from the 
Data Collector to Computer.

NOTE: 
- When using the event recorder function, the recording start time will be displayed 

even if in the Data Collector you have selected to download a specific range by time. 
For details about how to download to the Data Collector, see the User’s Manual 
supplied with the Collector.

- After gathering data info, it will be saved until the application is closed. However, if 
you do not close the application and connect to and transmit info with a different 
Data Collector or manipulate data from the Data Collector Unit, the data info stored 
in the application will be different from that in the Data Collector Unit. Please gather 
the data information again. 
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 To quit collecting data info already in progress:
By clicking [Quit Collecting Data Info], the collection will be stopped. For 
data beyond that point, detailed information cannot be collected and 
therefore will not appear in the display. 

Example of [Data Collector Contents] display

1.

2.

1. Collection of data info has been completed. Any operation can be 
performed. 

2. Collection was stopped and therefore data info cannot be displayed. Data 
can be collected and deleted. 
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 Downloading Recorded Data
1. By clicking on the [Detailed Settings] button, it is possible to make 

settings for what type of process you wish to occur after downloading. 
(See the next page. )

2. Select the desired data from the data list and click the [Download Data] 
button to start the downloading. 

[Download Data]
Button

[Detailed Settings]
Button

Select data from "Data 
Collector Contents" list.

During downloading, the 
[Downloading Status] Box will 
appear. By clicking the [Cancel 
Downloading] button, you can 
stop the downloading at any 
time.
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 When simultaneously downloading multiple sets of 
data:

By holding down the <Shift> key or <Ctrl> key and clicking on the data you 
wish to download in the data list, it is possible to select a multiple sets of data 
to download at one time. 

1.  By holding down 
the <Ctrl> key …

2.  By holding down 
the <Shift> key …

1. If you wish to download files not in a row (such as No.6 and No.8), hold down 
the <Ctrl> key and click on the files [No.6] and [No.8].

2. If you wish to download files in a row (such as No.1 to No.3), hold down the 
<Shift> key and click on the files [No.1] and [No.3]. 
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 Settings for Processing after Downloading:  
[Detailed Settings] Button

You can make settings for the processing of the downloaded recorded 
data. If you are downloading multiple sets of data at one time, all 
operations will be carried out according to the settings made in [Detailed 
Settings]. 

Check one

[OK]
 Button

After downloading, automatically show graph: 
Up to 8 channels of data can be viewed in the same graph window. Moreover, 
if you save the graph window using “Save As” command, it is possible to save 
multiple sets of data into one file. 

After downloading, save data in file: 
[Assign Data File Name] box will appear. Here you can assign a folder and file 
name in which to save the data. It will be saved with 3-digit data No. at the end 
of the file name. 
Example:  When saving data No.6, 10, and 150, at the end of the file name will 

be added [006], [010], and [150].

Extension Code
.trx : Common Thermo Recorder Type 
.vt7 : Voltage Recorder Type File
.thp : TR-73U Type File
.iur : Illuminance UV Recorder Type File

Data No.File Name
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 Other Buttons under [Download Recorded Data] Tab

1.

2. 3. 4. 

1. [Data Info Display] Button
Detailed info will be displayed in the "Data Info Box" about the selected data from 
the list for downloading. This can only be done with one set of selected data at a 
time. 

* However, info cannot be shown for Event Data.

2. [Delete Data] Button
Selected data saved in the TR-57 Series will be deleted from the Data Collector. 

3. [Delete All Data] Button
All data saved in the TR-57 Series will be deleted from the Data Collector. 

4. [Select All] Button
All data in the list will be selected at one time. Use this button to simultaneously 
download all data.
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TR-57U: Other Functions

 Making Settings for the Upper and Lower Limits: 
[Upper and lower Limit Settings] Tab

You can make settings for the Upper / Lower Limits with the Data 
Collector if they have not been set with the Data Logger. 

Example: For Temperature
[Upper and Lower Limit Settings] Tab

Check

[Write] 
Button

Enter 
values

Check [ON] if 
you wish Limit 
Judgment to 
occur.

[Read] 
Button

1. Connect the Data Collector to your computer. 
- For details about connecting to your computer, see pages 18-19. 

2. Click the [Upper and Lower Limit Settings] tab and place a check next 
to [Change] to enter upper and lower limit values. 

3. After entering the Upper and Lower Limit Settings, check the <ON> 
under Limit Judgment and click the [Write] button to have the settings 
sent to the Data Collector. 

ON: Data will be checked and judged as to whether or not it falls within the 
set upper and lower limits. 

Off: No judgment will occur, even if upper and lower limits have been set.

NOTE:

- This function is available in the TR -57 Series version 2.0 or later. To check the 
version of a Data Collector, select “Data Collector Version Info” in the [Help] menu.

- Please note that TR-57DCi does not have an upper and lower limit settings function.
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[Read] Button
If you wish to view the current settings, click the [Read] button. 

 Shift Unit (°C / °F): [Display] Menu
The Upper and Lower Limit settings can be made in either Celsius or 
Fahrenheit. In the [Display] menu, by clicking on [Shift Unit (°C / °F) ] the 
display will change in the settings window. 

[Display] Menu
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Communication Port Settings

Make settings for USB and/or RS-232C communication. In the 
TR-57U/TR-57DCi [Communication] Menu open [Communication 
Port Settings]. 

[Communication] Menu Communication Port Settings
Window

- For details about Communication Port Setting Procedures see p.28-30. 
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Graph
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Temperature/Humidity Graph

Open the Graph display by clicking the icon [Temp/Humid Graph] in 
the Main Window.

Click

- Open by selecting [Open Temp/Humidity Graph] in the [File] Menu of the 
TR-71U/72U/73U/77Ui, TR-51A/52, TR-51i/52i, TR-51S/52S Settings and 
Communication Window. 

- If you have checked [After downloading, automatically display graph] in the 
detailed settings, the graph program will automatically open. 

NOTE:

- When viewing a Graph, small differences in time may occur. For details see 
"Troubleshooting" on P.108. 

 Display Names and Functions

1.
2.

3.

4.
5.

6.

7.

1. Graph Area
The area in which the Graph is displayed The horizontal axis shows time and the 
vertical axis shows temperature / humidity data.
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2. Menu Bar
Menus are lined up which contain various commands. They are used to view data 
or to make settings for the various functions in each menu.

3. Toolbar (Icons)
Buttons appear for frequently used commands.

4. A and B Cursor Bars
By cl icking the arrow buttons at the left and r ight of the bar, you can 
simultaneously move the A/B cursors. Click and drag the A or B Button on the bar 
to move the cursor to the left or right.

5. A and B Cursor Position Information
The approximate date and time for the A and B cursor positions and the time 
difference between the A cursor and the B cursor is displayed.

6. Channel Info Display
The detailed data info for each channel 1 to 8 is displayed below the Graph 
Display. 

        [Channel Info Display Items]

ch Drag the channel name / number you wish to move to the newly desired channel 
name / number position and drop it.

Name Channel Data Name Interval Recording Interval

Sample Number of data Max. Highest Reading

CursorA Cursor A position data Min. Lowest Reading

CursorB Cursor B position data Avg. Average Value

A<->B Calculated Temp / Humidity Difference 
between Cursor A and B

Unit Unit of measurement

7. Horizontal Gauge Bar and Button for Moving Horizontal Axis
The time axis moves by clicking the [ ] , [ ] buttons at the left and right of the 
bar. By dragging the gauge you can move left and right to the data you want to be 
displayed.

The vertical axis moves up or down by clicking the [ ] , [ ] buttons at the upper 
and lower sides of the bar. By dragging the gauge you can move up and down to 
the data you want to be displayed.
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*When opening data recorded in TR-73U units into a graph
When opening a file containing barometric pressure data ([thp] format file), the 
window is different from the standard, with the scale for barometric pressure 
appearing on the right side.

*For details, see Temperature/Humidity Graph [Help] - [Keyword] - [About 
Barometric Pressure].

Scale for Barometric Pressure
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 Zooming In and Out on the Graph

Zoom in Using the Mouse
With the left Button drag the mouse to outline the area you want to zoom in 
on.

Menu Display Using the Mouse
By right clicking on the graph, the Menu will be displayed. With [Return to 
Original Size] or [Step-by Step Return to Original] you can return both the 
vertical and horizontal axis back to show the entire graph.

- These operations can be carried out via commands in the [Graph] Menu or 
by clicking icons in the Toolbar.

About the Horizontal Axis
The entire graph shows in the horizontal axis the nearest data to the recording 
start time and the latest data nearest the recording finish time for each channel 1 
to 8. This represents the full scale of the horizontal axis.

About the Vertical Axis
The entire graph shows in the vertical axis the lowest possible measurement 
value and the highest possible measurement value for channels 1 to 8. This 
represents the full scale of the vertical axis.
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 Data List Display

[Date / Time] Button
By clicking this Button, you can shift the display between the recorded date 
and amount of elapsed time since recording started.

[Date / Time] Button

Recorded Date 
Display

Elapsed Time 
Display

This is a list of the data that was displayed in graph form. The highest value 
is in RED, lowest is in BLUE, and the average is in PINK.

Scroll Bar: By dragging it up and down you can move to the data you want.

Menu Display Using the Mouse
By right clicking on the list, the Menu will be displayed.
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Editing the Graph: [View] Menu

[View] Menu

 Changing graph display colors: [View] Menu
You can change the letters used in the data list display for each channel 
between monochrome and channel color.

 Selected Channels ON/OFF: [View] Menu
1. The channel numbers are displayed in the pull down menu of [Selected 

Channels ON/OFF].

2. Check the channel numbers you wish to display.

Check

Enlarged

* By clicking a Channel Number in the Toolbar, you can carry out the same 
operation.
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Editing the Graph: [Tools] Menu

[Tools] Menu

 Set High, Low, Average Calculation Range: [Tools] Menu
1. Set the calculation range in the [Set High, Low, Avg. Calculation 

Range] box.

2. By clicking the [OK] Button, the high, low, average calculation range of 
each channel data will be changed. On the graph display, the 
calculation range that you have set will be displayed.

[Entire Graph]
Button

[OK]
Button

Enter the
numerical value

[Entire Graph] Button
To make the Calculation Range that of the Entire Graph, click the [Entire Graph] 
Button. The dates and times in the [Set High, Low, Avg. Calculation Range] box 
will be displayed as those of the entire graph.

Set by using the AB Cursors
In the Graph Display, open the [Set High, Low, Average Calculation Range] box 
adjusting the AB cursors to the desired start and end positions. The dates and 
times of those cursors will be displayed automatically.
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 Edit Recording Conditions: [Tools] Menu
1. By clicking the [Ch.] Button you wish to change, the information for that 

number will be displayed in the [Edit Items].
2. By clicking the [OK] Button after changing, the setting will be 

completed.

[OK]
Button

[Restore]
Button

Enter letters and
numerical values

Channel Number

The selected
channel number

NOTE:

- Name: Up to 32 letters can be entered.
- Starting Date/Time: The month, day, year, hour, minute and second can be changed.
- If you wish to continue to change other channels, repeat the process as in 1.
- The [Restore] Button is effective only during the setting, and cannot return to the 

condition it was after the [OK] Button has been clicked.
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 Re-order Channel Data: [Tools] Menu
There are two ways for re-ordering.

- Move by dragging the channel number
- Move by selecting the channel number

[Move by dragging the channel number]
Click on the channel of data you wish to move and drag and drop it to the 
desired new channel position.

[Move by selecting the channel number]
1. Enter in From: _, the Channel number you wish to move from, and enter the 

Channel number to which you want to move in To: _.

2. By clicking the [Re-order] Button, the movement will be completed.

NOTE:

- The [Restore] Button is effective only during the setting, and cannot return to the 
condition it was by clicking the [OK] Button.

[Re-order]
Button

[OK]
Button

If you wish to move Ch3. to Ch7. simply 
set From -> Ch3, To -> Ch7.

Drag and drop the channel 
number to the desired new 
position.
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 Erase Selected Channel Data: [Tools] Menu
1. Put a check on the channel number you wish to erase.

2. By clicking on the [OK] Button, the deletion will be completed.

[OK]
Button

Put a check on the 
check box

 Shift Unit (°C / °F): [Tools] Menu
By clicking on [Shift Unit( °C / °F)], you can automatically change the 
temperature unit scale in the graph display and in the channel info list.
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 Change Graph Colors: [Tools] Menu
1. Click the channel number of which you wish to change the color.

2. By clicking each Button, color samples will be displayed. Choose the 
color you want and click the [OK] Button.

3. After confirming the color, by clicking the [OK] Button the change will 
be completed.

Color Sample

[Channel No.] Button

[OK]
Button

[Line Width...]
Button

[Default]
Button

NOTE:

- By clicking the [Return to Default] Button, you will return to the color settings when 
the software was opened.

[Line Width...] Button
Change the width of the data lines and the scale lines.

Every time you click on 
- Every time you click on , the numerical value gets larger.
- Every time you click on , the numerical value gets smaller.
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 Copy Display to Clipboard: [Tools] Menu
By clicking [Copy Display to Clipboard], you can copy the currently 
displayed window to the clipboard and make use of the graph by pasting 
to other software.

 Operating the Graph: [Graph] Menu

Return to Original Size
Return from zooming in on one part of data

Zoom In / Zoom Out
Zooms in or out one step at a time

Move Cursor Right / Left
Simultaneously move the AB Cursors to the right or left.

Move Graph Right / Left
Move the Graph Display to the right or left.

Move Graph Up / Down
Move the Graph Display up or down.

Vertical Axis Settings (AUTO in Default Settings)
Set the vertical axis scale (temperature)

1. Check either [Auto] or [Manual].
- AUTO: The vertical axis will automatically be changed according to the values of 

the data.

- MANUAL: You can set the upper and lower values of the vertical axis scale.

For TR-5, TR-5i, TR-5S, TR-71U/72U/77Ui

[OK]
Button

Enter the range of the 
vertical axis scale.
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For TR-73U

[OK]
Button

Enter the range of the 
vertical axis scale.

2. Click [OK] to complete the settings.
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Multi-scale Graph

This software, Multi-scale Graph is designed to allow you to view 
simultaneous display of graph channels with different scales such 
as temperature, humidity, voltage, pulse and moisture data in one 
window.
The [Multi-scale Graph] program will read data files that have been 
created from the downloaded data from the loggers and to help you 
analyze that data will allow you to create graphs, data lists, text files 
and print data. It is also possible to scroll across the graph and 
make scale settings for each channel.

Note

- For detailed information about the compatible data file types for the [Multi-scale 
Graph], see the Multi-Scale Help Menu.

Open the Multi-scale Graph by clicking the [Multi-scale Graph] icon 
in the Main Window.

Click

Note

- If you have checked [After downloading, automatically display graph] in the detailed 
settings, the graph program will automatically open. 
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 Display Names and Functions

Graph Area
The area in which the Graph is displayed. The horizontal axis shows time 
and the vertical axis shows the unit of data after having used the 
conversion equation to convert the original measured voltage. 

A / B Cursor Movement Buttons and A / B Cursor Buttons
By clicking one of the arrow buttons at either side of the bar, you can 
simultaneously move the A/B cursors. Click and drag the A or B Button to 
move the cursor to the left or right.

A and B Cursor Position Information
The approximate date and time for the A and B cursor positions and the 
time difference between the A cursor and the B cursor is displayed.

Channel Info List Display
Displays data information for Channels 1 to 8. The list contains the 
following info: Channel Name, Recording Interval, Amount of Data, Data 
Values for AB Cursor positions, the High, Low and Average values for the 
set calculation range.

The Vertical Axis Display ON/OFF
Shift the vertical axis scale display ON/OFF.
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Vertical Axis of Each Channel

The vertical axis scale is displayed for each channel. By clicking [ ], the 
axis can be scrolled for each channel.

Menu Bar
Click on the desired menu in the Menu Bar to set or display each function 
from which you can choose from an array of commands.

Toolbar
Buttons appear for frequently used commands.

Open File
Overwrite Data
Data List Display
Return to Original Size
Step by Step to Original
Set High, Low, Avg. Calculation Range
Edit Recording Conditions

Re-order Channels
Merge Channel Data
Erase Selected Channel Data
Print Preview
Help
Hide / View Channels

Horizontal Gauge Bar and Button for Moving Horizontal Axis
By dragging the gauge you can move left and right to the data you want to 
be displayed. The time axis moves by clicking these arrow buttons.

Vertical Gauge Bar and Button for Moving Vertical Axis
By dragging the gauge you can move up and down to the data you want to 
be displayed. The vertical axis moves up or down by clicking these arrow 
buttons.

Calculation Range Button
By clicking the [Calculation Range] Button, the high, low, average 
calculation range of each channel data will be changed. On the graph 
display, the calculation range that you have set will be displayed. This 
operations can be carried out via commands in the [Tools] Menu. See P.76 
for details.
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 Zooming In and Out on the Graph

Zoom in Using the Mouse
With the left Button drag the mouse to outline the area you want to zoom in on.

Menu Display Using the Mouse
By right clicking on the graph, the Menu will be displayed. With [Return to Original 
Size] or [Step-by Step Return to Original] you can return both the vertical and 
horizontal axis back to show the entire graph.

Distributed by MicroDAQ.com, Ltd.                   www.MicroDAQ.com                   (603) 746-5524



Graph 91 

 Data List Display

[Date / Time] Button
By clicking this Button, you can shift the display between the recorded date and 
amount of elapsed time since recording started.

 

Elapsed Time
Display

Recorded Date 
Display

[Date / Time] Button

 This is a list of the data that was displayed in graph form.  
The highest value is in RED, lowest is in BLUE, and the average is in PINK.

 Scroll Bar: By dragging it up and down you can move to the data you want.

Menu Display Using the Mouse
By right clicking on the list, the Menu will be displayed.
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Editing the Graph

 Selected Channels ON/OFF: [View] Menu
1. The channel numbers are displayed in the pull down menu of [Selected 

Channels ON/OFF].

2. Check the channel numbers you wish to display.

Check

Enlarged

Note

- By clicking a Channel Number in the Toolbar, you can carry out the same operation.

 Scale Display ON/OFF: [View] Menu
1. The channel numbers are displayed in the pull down menu of [Selected 

Scale ON/OFF].

2. Put a check next to the channel number(s) you wish to be displayed.

Check

Enlarged

Note

- You can also hide or view channel scales by checking the channel number of the left 
of the graph.
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 Setting High, Low, Average Calculation Range: [Tools] Menu
1. Set the calculation range in the [Set High, Low, Avg. Calculation Range] 

box.

2. By clicking the [OK] Button, the high, low, average calculation range of 
each channel data will be changed. On the graph display, the calculation 
range that you have set will be displayed.

[Entire Graph]
Button

[OK]
Button

Enter the
numerical value.

[Entire Graph] Button
To make the Calculation Range that of the Entire Graph, click the [Entire Graph] 
Button. The dates and times in the [Set High, Low, Avg. Calculation Range] box 
will be displayed as those of the entire graph.

Set by using the AB Cursors
In the Graph Display, open the [Set High, Low, Average Calculation Range] box 
adjusting the AB cursors to the desired start and end positions. The dates and 
times of those cursors will be displayed automatically.
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 Editing Recording Conditions: [Tools] Menu
1. By clicking the [Ch.] Button you wish to change, the information for that 

number will be displayed in the "Edit Items".

2. By clicking the [OK] Button after changing, the setting will be completed.

Channel Number [Restore]
Button

[OK]
Button

Enter letters and
numerical values

The selected
channel number

- Name : Up to 32 letters can be entered.

- Starting Date/Time : The month, day, year, hour, minute and 
second can be changed.

Note

- If you wish to continue to change other channels, repeat the process as in 1.
- The [Restore] Button is effective only during the setting, and cannot return to the 

condition it was after the [OK] Button has been clicked.
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 Re-ordering Channel Data: [Tools] Menu
There are two ways for re-ordering.
- Move by dragging the channel number
- Move by selecting the channel number

Move by dragging the channel number
Click on the channel of data you wish to move and drag and drop it to the 
desired new channel position.

Move by selecting the channel number

1. Enter in From: _, the Channel number you wish to move from, and enter 
the Channel number to which you want to move in To: _.

2. By clicking the [Re-order] Button, the movement will be completed.

Drag and drop the channel number to the 
desired new position.

[Change 1 and 2]
Button

[OK]
Button

I f you wish to move Ch3 to Ch7. 
simply set From Ch3,
 To Ch7.
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 Merging Channel Data: [Tools] Menu
You can merge two different sets of data into one set of data.

1. Click the [ ] Button, and select the channels you wish to merge.

The following kinds of data cannot be merged:

- Recording intervals are different

- Measurement times overlap (Merging is possible after adjusting 
the times in [Editing Recording Conditions])

- Data types are different (Merging is possible between same types 
of data; like temperature/humidity)

Example)
I f you wish to merge 
Ch.3 with Ch.7

[OK]
Button

[Merge]
Button

2. By clicking the [Merge] Button, the merging will be completed.

3. Click the [Close] Button to finish the merging.

Note

- The channel number and other conditions of the merged data will become those 
conditions set in the channel that you selected in the second box.
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 Erasing Selected Channel Data: [Tools] Menu

1. Put a check on the channel number you wish to erase.

2. By clicking on the [OK] Button, the deletion will be completed.

[OK]
Button

 Check
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 Vertical Axis Range Display Settings: [Tools] Menu
You can set the upper and the lower limits of the graph's vertical 
axis scale for each channel.

1. Check [Fixed] of the channel you wish to set.

2. Enter upper and lower limit values.

Set the lower limit at more than -40,000 and set the upper limit at 
less than 40,000.

Select [Fixed] and enter
numerical values.

If you wish to make all of the 
settings the same.

[OK]
Button

3. By clicking the [OK] Button, the setting will be completed.

Note

- If you have put a check on [Fixed], the lines in the graph may exceed the boundaries 
of the graph. 

[Making all channel settings the same as Ch.1]
Set CH.1 [Fixed] and by putting a check on [Make all Settings the same as 
Ch.1]; all channel settings will be the same as CH.1 regardless of other 
channel settings.
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 Scale and Unit Conversion: [Tools] Menu
You can convert the scale and the unit of downloaded data for each 
channel.

1. Select from [Designate by 2 points] Tab or [Designate by y=ax+b] Tab.

[Designate by 2 points] Tab

[Designate by y=ax+b] Tab

Conversion
Info

[OK]
Button

2. Set conversion formulas and units.

3. By clicking the [OK] Button, the setting will be completed. 

[Conversion Info]
Current conversion formulas and units are displayed here.
Y indicates the data after conversion, and x indicates the voltage entering 
from the sensor.
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 Changing Graph Colors: [Tools] Menu

Color Sample

Image Preview

Memo

[Channel Number]
Button

[ ] Button

[ ] Button

[Default]
Button

[Close]
Button

1. Click the [Channel Number] Button, and click the Button of the item that 
you wish to change.

  - When changing colors, click on a Button to display the color samples. Choose 
the desired color and click the [OK] Button to change the color.

  - If you wish to change line width, every time you click the [ ] Button, the width 
gets wider, and every time you click the [ ] Button, the width becomes more 
narrow.

2. Confirm the width in the image preview and click the [Close] Button to 
complete the change.

  - By clicking the [Return to Default] Button, the color settings will return to the 
default settings.

[Memo]

You can save the settings for Display and/or Print respectively.

1. Select Display or Print.

2. By clicking the [Save] Button, the settings will be saved.
  - By clicking the [View] Button, you can see the settings that had been previously 

saved. 

Select one

[Save] Button [View] Button
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Saving Recorded Data

If you have checked [After downloading, automatically show graph.], 
make sure to save data after displaying the graph or editing any 
data.

 3 Ways to Save Files: [File] Menu

- In the [File] Menu, select [Overwrite All Data]
Will save any changes to file without changing File Name and Saving Location. 
The same operation can be carried out from [Save] in the Toolbar.

- In the [File] Menu, select [Save All Data as...]
Save with a new File Name.

- In the [File] Menu, select [Save Displayed Data]
Save only that data in the current display. This is handy when you wish to save 
only the desired data.

EX: [Save All Data as...]

1. Select [Save All Data as...] in the [File] Menu.

2. Specify the [Location] and enter a [File Name].

3. Click [Save] to complete the saving process.

Enter a File Name

Specify Location

[Save]
Button
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Creating Text File

By saving the recorded data as text file, you can create a file type 
that can be read by common spreadsheet software. 

1. Click [Save Data in Text File] in the [File] Menu.

2. Select the [Text File Type] and [Range to be saved], and click [OK].

- Comma, Tab, Space, and Semi-colon are codes used by common 
spreadsheet software, such as Excel and Lotus, when reading Text File to 
divide cells.

Select the Delimiters Select the Range to 
be Saved

[OK]
Button

3. Designate the location to which the file should be saved and click [Save] 
to create and save the data as a Text File document.

[Save]
Button

NOTE:

- The extension for the created file will be [.txt].
- Text File cannot be read into T&D Recorder for Windows graphs.
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Opening a File

To open a previously saved file, designate the file name to open it. 
To open multiple files at once, hold down the <Ctrl> key and select 

the files you with to open. 

1. Select [Open] in the [File] Menu.

2. Select the name of the data you wish to open and click [Open] to view 
the data in graph form.

[Open]
Button

Selected File Info

Selected File Name

Select a File
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Other
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How to Re-install

Before re-installing the software, make sure to carry out the 
uninstall program first. Before you begin the uninstall program, first 
make sure to quit all T&D Recorder for Windows programs.

NOTE:

- Even after uninstalling, saved data files will still remain in the folders and locations 
they were saved in. Also, saved Remote Unit registration info may still remain. If 
you wish to delete all of these data and registration files, make sure to delete all of 
the relevant folders after uninstalling but before re-installing. 

 For Windows XP

1. In the Windows Control Panel, click on [Add/Remove Programs].

2. From the list of currently installed programs, select [T&D Recorder for 
Windows] and click the [Add / Remove] Button. 

3. The [Install Shield Wizard] will appear. Check [Remove], and click [Next].

Check 

[Next]
Button

4. Follow the directions to Un-install.

5. To re-install, follow the directions to [Install].
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 For Windows Vista / 7

1. In the [Control Panel ] , click [Program – Program Uninstall] . 

2. From the list of currently installed programs, select [T&D Recorder for 
Windows] and click the [Uninstall] Button. 

3. The [Install Shield Wizard] will appear. Check [Remove], and click [Next].

Check 
[Next]
Button

4. Follow the directions to Un-install.

5. To re-install, follow the directions to [Install].
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Troubleshooting

Q:  The computer won't communicate via the Serial Port. What 
should I do? 
A: Try two or three times to find the port connection by using the Auto-

detect function.

A: Check to make sure that the power of the main unit is ON.

A: Check to make sure that the connection is proper. Communication will 
take place only through the serial port (RS-232C) and will not work 
through the printer port or any other port.

A: Check to make sure that you can control the Thermo Recorder via the 
software.

A: If you have access to another computer, try seeing if communication 
works with the other computer.

A: If you have a computer with energy saving function settings, make sure 
that the serial port has not been turned off.

A: Check to make sure that the serial port has not been rendered unusable 
by the BIOS setting.

A: Make sure that the serial port setting has not been made to render the 
port unusable. With some computers, especially all-in-one computers 
the serial port serves as the modem jack.

 How to check: Checking with the Device Manager
For Windows Vista / 7
1. From the [Control Panel], click on [System and Maintenance] - [Device 

Manager]; and the Device Manager Window will be displayed.

For Windows XP
1. In the [Control Panel], click on [Performance and Maintenance] - 

[System] ; then click [Properties]. 

2. In the System Properties Window, click on the [Hardware] Tab, then click 
on the [Device Manager] Button to view the Device Manager Window.
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 How to check
In the [Device Manager], click on [Port (COM&LPT)] and check to see if 
under that appears [Com Port (COM1)] or [Com Port (COM2)]. 

If a port appears, it should be usable.

- If a mark [ ! ] or [ x ] appears next to the port, this communication port is 
unusable. If you cannot use a communication port please contact your 
computer company.

[Device Manager] Window

Communication Port Icon with an 
[ x ] mark

- To find out more details about an unusable communication port:  
Select the port with a [ ! ] mark, and then click on [Properties] to view 
the details about that port.

Example of Device Details Display

Device Status 
Message

Device usage
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A: I f your computer has an internal modem, make sure that the 
communication port is not being used by it. When the communication 
port is being used as the modem port, that port cannot be used. Either 
quit using the modem or use another port.

 How to check: for Windows XP
1. Open the [Device Manager] following the steps outlined on P.82. 

2. Under [Modems] right click on [Communications cable between two 
computers] then in the pop-up menu click on [Properties], in a short 
time a new window will appear. 

[Device Manager] Window (extract)

3. By clicking on the [Modem] Tab, you can check which communication 
port the modem is using. 

Example of when Modem is 
using Communication Port 
(COM 1)

A: Sometimes communication will not work if a switch has been added to 
the serial port (RS-232C) or an extension cable has been added to the 
communication cable. 

A: Check to see if some other communication software is in use.

A: If your desktop computer has two serial ports, try connecting the 
communication cable to the other port and try communicating again.
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Q:  I can't get the communication cable connected to the 
computer. What should I do? 
A: Please connect the communication cable provided with the Thermo 

Recorder into the serial port of your computer (D-SUB 9 pin male 
connector). If for some reason you cannot connect directly, please use an 
appropriate adapter (gender changer plug) as explained below.

- If the connector on your computer is a D-SUB 9 pin male then there is no need for an adapter.
- If the connector on your computer is a D-SUB 25 pin female then use an adapter (D-SUB 25 

pin male to a D-SUB 9 pin male).
- If the connector on your computer is a Half pitch 14 pin female then use the adapter (Half 

pitch 14 pin male to a D-SUB 9 pin male) or a combination (Half pitch 14 pin male to D-SUB 
25 pin male) and (D-SUB 25 pin female to a D-SUB 9 pin male).

Q:  The date and the time of the recorded data are different from 
the actual date and time of recording. Why?
A: The Thermo Recorder has no internal clock. When you set up a 

programmed recording start or when you download data, the date and 
time that are shown are taken form your computer's clock. If your 
computer's clock is not correct, it will affect the recorded data.

A: When recording mode has been set to [Endless] and Recording Start 
was carried out via PC, the time for recorded data is calculated from the 
recording start date and time and will appear correctly in the Graph as 
long as recording capacity has not reached its limit. However, once data 
capacity has become full and the oldest data is overwritten, the date 
and time for downloaded data in the Graph will be calculated using the 
PC's clock for the latest recorded data and subtracting backward. Hence 
the time for the displayed data will be different from the actual time the 
data was recorded.
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Specifications

Compatible Devices
Data Logger:
Data Comm. Devices

TR-71U/TR-72U/TR-73U/TR-77Ui, TR-51A/TR-52, TR-51i/TR-52i, 
TR-51S/TR-52S*1, TR-50U/TR-50C, TR-57U/TR-57DCi, TR-74Ui.*2 
*1  To properly use a Data Logger in the TR-5/TR-5i/TR-5S Series, it is necessary 

to use in conjunction with one of our Data Communication Devices. 
*2  For TR-74Ui, only the data downloaded via TR-57DCi Base Unit can be used 

with "T&D Recorder for Windows". 

CommunicationFunctions
TR-7U Series: Start Recording (Immediate Start/Programmed Start) ,

Stop Recording, Get Unit Settings (Channel Names, Recording Interval 
and Recording Mode. also possible to make settings), 
Download Recorded Data, Gather Current Readings, Adjustment, 
Application Settings 

TR-5 Series: Start Recording (Immediate Start / Programmed Start) ,
Download Recorded Data

TR-5i Series,  
TR-5S Series:

Start Recording (Immediate Start / Programmed Start),
Stop Recording, Get Unit Settings, Download Recorded Data, 
Warning Settings, Adjustment, Application Settings, 
Infrared Communication Settings (TR-5i) 

Temp/Humidity Graph
Graph: Temp/Humidity Graphs for Each Channel (Zoom out / sin and scroll),

Change Channel Colors, Turn ON and OFF Channel Display

Data Display: Channel Name, Recording Interval, Number of Readings, 
Highest / Lowest and Average Reading, Unit of Measurement, 
AB Cursor Dates / Times and Data Readings, 
Calculated Difference between Cursor A and B

Number of Channels: 8 Channel Simultaneous Display and Processing

Others: Data List Display, Calculation Range Settings, Data Maintenance,  
Edit Recording Conditions, Delete Data by Channel, 
Re-order Data by Channel

File Output:
TR-Series Common Data Files (*.trx) / Text File (CSV, etc),
Selected Range: (File for selected time period)

Printing: Graphs / Tables
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Multi-scale Graph
Graph: Graphs for Each Channel (Zoom in/out and scroll with mouse or 

keyboard), Vertically Scroll Graph for Each Channel, Channel Graph Color, 
Background Color, Customize Graph Scale Lines, Turn ON and OFF 
Channel Display, Move Vertical Scale to Desired Position in Graph (View / 
Hide Scale for Each Channel)

Data Display: Channel Name, Recording Interval, Number of Readings, Highest / Lowest 
and Average Reading, Unit of Measurement, AB Cursor Dates / Times 
and Data Readings, Calculated Difference 

Others: Data List Display, Change Scales, Calculation Range Settings, Set Display 
Range for Vertical Axis

Compatible
OS: Microsoft Windows 7  32/64bit English

Microsoft Windows Vista 32bit English
Microsoft Windows XP 32bit(SP2 or above) English

Disc Capacity: More than 50MB free space (More free space is necessary for data)

Operating 
Environment: 

A Stable Windows Operating Environment
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   For product information or questions contact us at:

Shimadachi 817-1, Matsumoto, Nagano 390-0852 Japan

Tel: +81-263-40-0131  Fax:+81-263-40-3152 

E-mail: support@tandd.com

Office Hours: Monday to Friday 9:00-12:00/13:00-17:00 (GMT +9:00 Tokyo Time)

[Web Site]
Product information, FAQ and software update downloads.

http://www.tandd.com/
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